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Introduction 
 
The standard Census datasets (e.g. KS, QS, LC, DC) are geographically one-dimensional.  That is 
to say each item of information is related to a single area. That is why they are occasionally 
referred to as ‘single geography datasets’.  
 
On the other hand, the ‘origin-destination’ datasets supplied by the ONS are geographically 
two-dimensional – each item of data is linked to two areas. 
 
There are four origin-destination (O-D) datasets in 2011. In each case data are linked to two 
geographies (an origin and a destination): 
 

Data Set 
 

Geography 1 Geography 2 

Travel to work 
 

Usual residence  Address of place of 
employment 

Migration 
 

Usual residence  Address one year ago 

Second Homes 
 

Usual residence  Second home address 

Students Residence 
 

Usual residence  Term-time address one year 
ago 

Note: Either geography 1 or geography 2 can act as the origin or destination. 
 
 
Double Geography in SASPAC 
 
In order to access and output O-D data in SASPAC there are a number of double geography 
windows. These windows are very similar to the windows used in basic operations but with a few 
minor modifications in their appearance and the choices that are offered to the user. 
 
The migration, second homes and student residence data will all be available as United Kingdom 
datasets while only some workplace tables will be UK-wide. Other workplace tables will be 
provided as England & Wales only tables and Scotland only tables. This is because in Scotland 
the question relating to place of work was extended to cover place of study as well. The two 
relevant questions in each of the areas was as follows: 
 
E&W 
Q40. In your main job, what is the address of your workplace? 
 
Scotland 
Q11. What address do you travel to for your main job or course of study (including school)? 
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2011 Naming 
 
As with standard outputs each table in the O-D dataset has a unique name. The table names in 
the 2011 O-D dataset are complex because they provide information about the data contained 
in each table. Table names include: 

 A dataset identifier 
 A data type identifier 
 A table number 
 A country identifier 
 Migration tables include an additional population base identifier 

 
The list below shows each of the four O-D datasets, their formal name and the letter used to 
identify them. 
 

Dataset 
 

Formal Name Identifier 

Travel to work 
 

Special Workplace Statistics 
(SWS)  

W 

Migration 
 

Special Migration Statistics 
(SMS) 

M 

Second Homes 
 

Special Resident Statistics 
(SRS)   

R 

Students Residence 
 

Special Student Statistics 
(SSS)  

S 

 
The dataset identifier listed above is the first letter in the table name. 
 
The second letter of the table name denotes the type of data to be found in the table. Origin 
destination data are of three types: 
 

Data Type 
 

Formal Name Identifier 

Flow Count of people moving from one place to 
another 

F 

Univariate Number of people moving with a particular 
characteristic 

U 

Multivariate Number of people moving with two or 
more characteristics 

M 

 
 
Next, the tables have a two digit table number. This is followed by a country identifier (EW or 
UK).  
 
For example, table MF01UK is a Special Migration Statistics table which provides flow data for 
the UK. 
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In some cases where two tables provide similar data they are given the same table number and 
the difference is denoted by a letter inserted before the country identifier. In SASPAC these 
letters are placed after the country identifier.  
 

ONS example  SASPAC example 
 

MM05AUK MM05UKa  

MM05BUK MM05UKb 

 
Both of these are migration tables providing multivariate data for the UK, specifically NS-SeC of 
migrants by sex. Table A provides detailed NS-SeC information while table B provides grouped 
NS-SeC information. 
 
Finally the migration (SMS) tables have an identifier to show which population base is being 
used. This is because some data are published for All Usual residents (all) and some are 
published for residents whose address was previously outside the UK (non UK). Again these two 
types are denoted slightly differently in ONS and SASPAC outputs. 
 

 

ONS example  SASPAC example 
 

MM03UK_non_UK MM03UKi 

MM03UK_all MM03UK 

 
In the SASPAC outputs the all usual resident tables have no identifier as this is the standard 
population base. The non-UK tables are denoted by a lower case ‘i’ which stands for 
‘international’. 
 
2011 Code Examples 
 

Table Name Dataset ID Data Type ID Table No. Country ID 

WU07EW 
(WU07EW) 

W = 
Travel to Work 

U = 
Univariate 

07 = 
Table 7 

EW = 
England & Wales 

RM11AEW 
(RM11EWa) 

R = 
Second Residence 

M =  
Multivariate 

11A = 
Table 11A 

EW = 
England & Wales 

SF02UK 
(SF02UK) 

S = 
Students 

F = 
Flow 

02 = 
Table 2 

UK = 
United Kingdom 

MM01BUK_non_UK 
(MM01UKbi) 

M =  
Migration 

M = 
Multivariate 

01B = 
Table 1B 

UK = 
United Kingdom 

*SASPAC table names are shown in brackets 
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2001 Naming 
 
In 2001 the tables were released under three generic titles: 
 
Matrices of journeys to work (Areas of residence in England, Wales, and NI) 

Within SASPAC these tables are given the table identifier code SWS. There are 14 tables 
(plus one Northern Ireland variation). Seven of these – numbered SWS101 to SWS107 – 
are available at local authority district level; six – numbered SWS201 to SWS206 – are 
available at ward level; and one – numbered SWS301 – is available at Output Area level. 

 
Matrices of journeys to place of work or place of study (Areas of residence in Scotland) 

Within SASPAC these tables are given the table identifier code TVS. There are 14 tables. 
Seven of these – numbered TVS101 to TVS107 – are available at local authority district 
level; six – numbered TVS201 to TVS206 – are available at ward and postcode sector 
level; and one – numbered TVS301 – is available at Output Area level. 

 
Matrices of migration moves 

Within SASPAC these tables are given the table identifier code SMS. There are 16 tables 
(plus one Northern Ireland variation). Ten of these – numbered SMS101 to SMS110 – 
are available at local authority district level; five – numbered SMS201 to SMS205 – are 
available at ward level (and postcode sector level in Scotland); and one – numbered 
SMS301 – is available at Output Area level. 

 
 
Number of Flows 
 
Following the 2011 Census there are some 181,400 Output Areas, and over 8,570 wards in 
England & Wales. The resulting matrices of area to area moves for each of these levels have the 
potential to be very large. For example if there was a flow from every OA to every OA within 
England & Wales that would constitute a total of 32.9 billion flows. Obviously this is not 
possible as this number vastly exceeds the resident population. Therefore not all the 
combinations of origin zone and destination zone will actually produce a flow. 
 
 
2011 Disclosure Control 
In 2011 the ONS preferred method for disclosure control has been to edit table layouts to avoid 
the release of disclosive material. The advantage of this method is that the data that are 
released are of a much higher quality than was the case under the 2001 SCAM method (see 
below). 
 
The downside to the method is that many tables and variables have been dropped from the 
proposed outputs because they were deemed disclosive. Origin-destination data by its nature 
tends to deal in small counts and so this approach means that many of the O-D products 
proposed by ONS have not met the disclosure control standard, particularly at smaller 
geographies. 
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ONS has taken the decision to make only a small proportion of the O-D data from the 2011 
Census publically available. The more sensitive datasets must be accessed through one of two 
secure channels: 
 
1. Safeguarded 

The user must apply to ONS to gain ‘secure user status’. Once granted the user will have 
access to more detailed outputs. The tables will be downloadable from the UK Data Service 
and accessible through SASPAC. 

 
2. VML (secure) 

The ONS Virtual Media Laboratory (VML) is a secure system accessible only at ONS offices. 
Users can either apply to use the VML or request data from ONS. This level of security is 
reserved for the most disclosive data. 

 
 
2001 Disclosure Control 
In 2001 the Small Cell Adjustment Method (SCAM) applied by ONS to data was intended to 
remove the potential for disclosure. Under this method small counts of 1 or 2 were adjusted to 0 
or 3. Totals were then calculated using the adjusted data. 
 
The difficulty with this method is that for multivariate flow tables the counts are often very 
small and so a great number of the cells need to be adjusted. This makes the datasets 
unreliable; particularly at lower geographies and as a result using OAs as building blocks to 
higher geographies is not advised. 
 
 
2011 Release Schedule 
 
There are 178 origin-destination tables scheduled for release for the 2011 Census. The table 
below shows how they are distributed between the four table sets and two levels of geography 
(EW and UK). Also shown is the predicted level of access. 
 
Where a table is split between two levels of access larger geographies such as local authority will 
be accessed via the lower security level while the higher security level will be needed for more 
spatially specific/smaller outputs. 
 

Table 
set 

Public Safe- 
guarded 

Secure Part safe 
part secure 

Part public 
part safe 

Total 

SMS EW 3 13 12 2  30 

SWS EW 3 12 12 3  30 

SSS EW 1 2 2   5 

SRS EW 6 11 11 1 6 35 

       

SMS UK 3 18 26 6 5 58 

SWS UK 3 9 9 3  24 

SSS UK  4 4 1 3 12 

Total 3  69 76 16 14  194
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The first release of origin-destination data took the form of a small set of public tables 
published on 25 July 2014. For the most part these tables provided data at Local Authority or 
Merged Local Authority level. Some workplace (SWS) tables were available for MOSA 
geography. 
 
Smaller geographies are more likely to be included in the safeguarded or secure outputs dur to 
their more detailed nature. The next release is likely to be early September and will included the 
first safeguarded tables, some down to output area level. 
 
The following release is tentatively scheduled for November and will incorporate safeguarded 
and secure data for all available geographies.
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Example 
For areas of origin in England & Wales, extract the total numbers of persons, males and females 
travelling to work within the MSOAs in the London borough of Enfield, and map the output in 
SASPAC 
 
 
Working with Origin-Destination Data in SASPAC 
Before using output O-D data in SASPAC there are some preparatory steps that it is 
recommended are taken. These steps make these large datasets more manageable and the 
outputs more meaningful. 
 

 Step 1: Filter the flows to exclude any that are not relevant 
 Step 2: Rezone areas to produce asymmetric flows 

 
 
Filtering Flows 
As indicated, the datasets supplied by the Census Offices, and made available to SASPAC users 
as System Files cover areas across the whole of the UK (or parts as applicable). This means that 
there will be flows on the files that users will have no interest in, and which will not be relevant. 
 
Flows therefore fall into one of four categories: 
 

a. Flows within an area of interest 
b. Flows into an area of interest from the rest of the country 
c. Flows from an area of interest to the rest of the country 
d. Flows totally external to the area of interest 

 
This is depicted schematically here: 
 

 Destination within 
area of interest 

Destination outside  
area of interest 

Origins 
within 
area of 
interest 

Flows within area of 
interest 
A 

Flows from area of interest to 
the rest of the country 
B 

Origins 
outside 
area of 
interest 

Flows into the area of 
interest from the rest 
of the country 
C 

Flows wholly external to the 
area of interest 
D 
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Most users will only be interested in the shaded area within this diagram, and therefore the first 
requirement will be to reduce the dataset by removing the unshaded area (i.e. filtering the 
data). 
 
The area of interest (A) – in this example the borough of Enfield – is termed the Core Area. The 
two blocks shown as B and C are referred to as the Tails of the Dataset. 
 
 
Exercise A: Filter Data 
Create a sub-set of origin/destination data for zones in to out of and within the area of interest 
(Core Area).  
 
For this exercise the Core Area is the London Borough of Enfield. We have been asked for travel 
to work data and so we will create Special Workplace Statistics Tables at MSOA level. 
 
The requirement is to create a new System File containing only data related to a core area, and 
so the New System File task window is accessed through use of the File/New Task/Create New 
System File option. 
 
Select the appropriate Input System File (2011 CENSUS SWS WU01&2&3 - MSOA - E&W.SYS) 
in the usual way.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Once an origin/destination dataset is selected, the task window changes slightly in that there is 
an additional tick-box now available as shown in this image. 
 
This tick box allows the user to restrict the outputs to only flows within the core area; all flows 
with an external component (B & C) will be excluded. In this task we are interested in all flows 
which have some relationship with the core area so we leave this box un-ticked to ensure we 
have flows A, B and C from the diagram. 
 
Above this tick-box under the ‘Variables’ header it is possible to input selected variables to be 
saved, leaving this blank will automatically save all variables in the original system file. 
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The selection of the core area zones may now be made in the usual way through the 'Select 
Areas' command button. 
 
As a double geography file has been selected, the Select Areas window  has tabs titled 'Origins' 
and ‘Destinations'. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use the find button to locate the first MSOA in Enfield. The zone is selected by left-clicking and 
choosing ‘include’. Subsequent zones are selected by left-clicking. Once Enfield MSOAs 1-36 
have been selected the final zone (MSOA 37) can found by using the find button again. 
 
As the core area is to be symmetrical, that is the areas of origin within it are identical to the 
areas of destination, then the process of area selection may be simplified by clicking the 'Apply 
to both axes' tick-box. If the origins and destinations are different then separate selections can 
be made. 
 
Once the zones within the core area have been identified, click the 'Make Command' command 
button and close the window. 
 
The final stage is to allocate an appropriate name (Enfield SWS 2011) and label in the required 
locations in the task window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Once this is done, click OK give the command an appropriate file name. 
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When the command is run a new system file containing only the flows relevant to the core area 
is created. 
 
The System File Details display shows the number of flows  and the number of origins and 
destinations. In this case 34,145 flows, 2,880 origins and 2,174 destinations. The file is 
therefore much more manageable as is also shown by the fact that the original file of 326Mb 
has been reduced to less than 4.8Mb. 
 
 
Asymmetric Flows 
The file that has just been created will contain MSOA-to-MSOA flows related to the Enfield core 
area. As such it will contain, for example, flows with origins in MOSAs in the North East region 
to destinations in Enfield MSOAs. It is however highly probable that the user will not be 
interested in origins or destinations at such a fine level of detail where the distance involved is 
very large. In this case, the user will want to create new zones for areas outside the core area. 
 
In this example we will aggregate MOSAs outside Enfield in the following way: 

 Within London, South East and East regions MSOAs aggregated to Local Authority 
 Elsewhere in England MSOAs aggregate to Regions 
 In Wales MSOAs aggregated to country 

 
Within Enfield we will retain the MSOA geography. 
 
Exercise B: Rezone to asymmetric zones 
To undertake the rezoning we will use the gazetteer file ‘GAZ file for Enfield Core Area.gaz’. 
This file has been created for this purpose and allocates all external MSOAs to local authorities 
or regions in the manner outlined above. It has the existing zone (MSOA) in columns 1 to 9, and 
the new zone (districts/region) in columns 11 to 19, with no scaling factor. 
 
The first stages of the process are the same as for single geography rezoning, and the 
“File/New Task/Create New Zones..” route is followed, at which stage the system file created in 
the previous exercise is selected. 

 
The resultant window differs from the window 
seen in Module 4b in that this is double 
geography specific. In the central ‘Method’ 
section of the window the user can select 
what to do with areas on the input system file 
that are not used in the new zone creation 
commands. 
 
 

As we are not considering the Enfield MSOAs in the gazetteer file and we want those to appear 
as they are in the new system file, the ‘Include unused origins and destinations’ button is 
checked. 
 
As we are going to use a gazetteer file, the ‘Gazetteer Files’ button is used to take us to the 
next window, which is again different from that seen in Module 4b, as it again caters for double 
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geography. The main difference is that this window has two tabs which allow for gazetteer files 
to be chosen either to apply to both axes together or individually. This is shown in the next 
image.  
 
The appropriate input gazetteer file is selected in the usual manner by use of the ‘Input from…’ 
button. 

 
 The existing zone code 

is in columns 1 to 9, 
 

 the new zone code is in 
columns 11 to 19 
 

 There is no scaling 
factor. 

 
 
 
 
 

These values are entered into the appropriate boxes. In addition, the gazetteer file has a label 
element, and so the ‘With Labels’ box must be ticked. For the sake of obtaining a full check on 
the allocation of zones (MSOAs) in the new zone creation, the ‘Zone Echo On’ box is also 
ticked. When this is completed click ‘Save & Close’. 
 
Call the new System File [Enfield SWS LA and Region.SYS] 
 
Run the task. 
 
A check on the System File details reveals that we now have a file in which there are 7,279 flows 
with 195 origin zones and 192 destination zones, and the file size has been further reduced 
from 4.8Mb to 0.5Mb. 
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Using the origin/destination datasets 
 
Once the national dataset has been tailored to the user’s needs as detailed in the previous 
sections, it may be used in virtually the same way as any other SASPAC System File. The main 
difference that the user will notice is that, once a double geography system file has been 
selected, some windows have a slightly different appearance.. 
 
Exercise C: Output Data 
 
Exercise: For areas of origin in England & Wales, extract the total numbers of persons, males 
and females travelling to work within the London borough of Enfield, and map the output in 
SASPAC 
 
To start the task go to File > New Task > Export data > CSV file (OD). 
 
This produces a modified CSV task window.  
 
 
 
 
The CSV (OD) window 
includes a tick box that 
allows restriction of the 
analysis to flows wholly 
within areas of interest. 
 
 
 
 
 
Select variables 
The required variables are selected in the usual way by using the Search Tables button. Note 
that in the Select Variables window the Table Sets available from the drop-down menu are 
limited to the O-D datasets only. Select Travel to Work (E&W) and then take all three variables 
from the first table (WU01EW).  
 
From the Header Variables box select the OLABEL (origin label) and DLABEL (destination label) 
variables. These work in the same way as the ZLABEL variable does for standard single 
geography outputs. 
 
Save and Close. 
 
Select geography 
When the ‘Select Areas’ command button is clicked the radial searching is not an option, and in 
place of the ‘Explore Zones’ tab, there is a tab each for Origins and Destinations. 
 



Double Geography datasets SASPAC Training 

 

Page 136 Module 8 

We do not want to limit the origin locations in the output file (we have already created a system 
file that only includes data related to our core area). We therefore don’t need to make any 
selection in the Origins tab. 
 
In the destinations tab we want to limit to just those people commuting to Enfield. Therefore 
select the MSOAs in Enfield using left click > include. 
The  ‘Apply to both axes’ tick box allows users to easily select symmetrical origins and 
destinations. With this box ticked a selection made in the origin window is applied also to the 
destination window, and vice versa. In this case we must ensure the box is not selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click ‘Make Command’ and close the geography selection window. 
 
 
Input the system file and export CSV 
Select the system file that was previously created [Enfield SWS LA and Region.SYS]. 
 
Note that as soon as a System File is selected, the ‘Input System Files’ buttons are greyed out. 
This is because only one input file is allowed with double geography analyses.  
 
Give the output CSV file a name (Module 8.csv) and run the task. 
 
View in Excel 
The output can be viewed in Excel in the usual way. For each Origin (MSOA, LA or region) there 
is a record for the destinations to which residents commute and each record has three variables 
attached (total, males, females). 
 
Pivot Table 
In Excel click Insert and then Pivot Table. Drag ‘Olabel’ to the Row Labels box and ‘Dlabel’ to 
the column labels box. Then drag the first of the three variables to the Values box. If Excel 
defaults to the Count of this variable rather than the Sum you will need to click on the 
dropdown box next to the variable and select value field settings. Change to Sum and click OK. 
The produces a matrix of flows in and out of Enfield. 
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Exercise D: Mapping 
 
Close Excel and select ‘Go Mapping’ from the command screen in SASPAC to open Mapshore. 
 
We first open the appropriate boundary file – in this Asymmetric Boundary File.BDY – followed 
by the CSV file just created. As the CSV is a double geography file, to display the data go to 
Data>Desire Line Double Geography. Select the first variable (WU01EW0001) when prompted. 
 
The map is filled with arrows showing how many 
people move from each zone on the system file 
(districts, regions, MSOAs) to each MSOA within 
Enfield.  
 
The smallest flows are represented as a red arrow 
while larger flows are represented by green, blue 
and violet arrows. 
 
Using the zoom icon in the centre of the shortcut 
panel draw a box around north London (the area of 
blue at the focus of the map). 
 
 
Use of Zoom/Layering 
 
Once zoomed in use the Zoom>Layering>Properties menu to edit the size of the arrows. 
 
This brings up the window shown here, in which 
the user can set arrow widths, arrow colours, and 
range values. Setting an arrow width to zero will 
prevent that range from displaying on a map. 
 
Set the values as shown here click OK and see how 
that changes the map. To display the legend go to 
Display > Desireline Key. 
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Exercise E: Limiting the Flows 
 
In this exercise we will output a new CSV using the same data and system file as previously but 
this time we will limit the output to solely flows within the area of interest. 
 
The first part of this exercise is identical to the previous exercise. 
Select CSV (OD) output from the File > New Task > Export Data menu 
Input the 2011 SWS ENFIELD ASYMETRIC System File 
Select variable WU01EW0001 
Give the CSV a name [module 8 part 2.CSV] 
 
Select Geography 
Go to select areas and view data. This time select all MSOAs in Enfield in the Origins window. 
Now make sure you tick the ‘Apply to both axes’ tick box and choose Make Command. This will 
apply your geography selection to both the Origins list and the Destinations list. Close the 
Select Areas window. 
 
Limit Flows 
The final step is to tick the ‘Limit flows from selected origins to selected destinations’ box. 
 
This means that our output will constitute a 
closed system where the only flows included will 
be ones from selected origins to selected 
destinations. 
 
As a result total outflow will equal total inflow (in 
this case 37,198 journeys). 
 
 
Output CSV 
The task can now be run. View the output in Excel. 
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Exercise F: Mapping 
 
Map the Enfield to Enfield flows that were output in the previous task. 
 
Clear the map and input the Enfield MSOA boundary. Load the CSV file [Module 8 part 2.csv] 
using the Data > Desire Line Double Geography option. Select the WU01EW0001 varibale. 
 
This will map all of the MSOA to MSOA flows in Enfield. As previously the map contains a lot of 
information and working with the options in Zoom > Layering > Properties can assist in making 
a more useful visualisation. 
 
Setting the values as shown below will produce the map shown here. 
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Additional output facilities available only with Double Geography datasets 
 
In addition to the usual Print Tables and Print Variables options, there are three other Print 
options that are only available when a double geography dataset has been input. These are: 

 Print Summary 
 Print Netflow 
 Print Matrix 

 
Print Summary 
A Print Summary task will print the following for each of the variables selected for output: 
 
Row Total The total number for the area as an area of origin, i.e. it is the sum of flows 

from that area of origin to all destinations. 
 
Column Total The total number for the area as an area of destination, i.e. it is the sum of 

flows to that area of destination from all origins 
 
Intra The total number of flows within the area, i.e. the area is the area of origin and 

destination 
 
Row Max The value of the largest flow from the area as an area of origin 
 
Row Count The total number of destinations with an origin in the area, and the number of 

these with a non-zero value for the selected variable 
 
Column Max The value of the largest flow to the area as an area of destination 
 
Column Count The total number of origins with a destination in the area, and the number of 

these with a non-zero value for the selected variable 
 
Sample output from a Print Summary task is shown below. 
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Print Netflow 
 
A Print Netflow task will print the following for each of the variables selected: 
 
Out flow The value for the selected variable of the flow from the first area to the second 

area i.e. it is the value when the first area listed is considered as the origin, and 
the second area is considered as the destination 

 
In flow The value for the selected variable of the flow to the first area from the second 

area i.e. it is the value when the first area listed is considered as the 
destination, and the second area is considered as the origin 

Ratio  The ratio of the Inflow to the Outflow 
 
Net flow The difference between the Inflow and the Outflow 
 
 
Sample output from a Print Netflow task is shown below: 
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Print Matrix 
 
A Print Matrix task will print the matrix of moves between selected zones for the selected 
variables, with the areas of origin being the rows, and the areas of destination the columns. 
 
Sample output from a Print Matrix task is shown below: 
 

 
Note that the largest values are usually along the diagonal, as they represent the ‘within zone’ 
flows. 
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Summary of task sequences 
 
 
Step 1 – Create a subset of the origin/destination datasets: 
 

 
 
 
 
 
 
 
* remember to ‘Apply to both Axes’ as the selection is symmetrical and ‘make command’ 
 
 
 
Step 2 – Re-zoning areas outside the core area: 
 

 

 

 
 

 
 
 
 

 
 
 
* insert double quotes around the .gaz file if there are any blanks in the directory or file name 
and the command ‘Test 71’ 
 
 
 
 
 
 
 

Create a new 
System File 

What sort of 
task is this? 

Input 
System File 

Select Areas* 

Output 
System File 
name/label

System File 
details

Run 
Task

Create a 
New Zone 

What sort of 
task is this? 

Investigate 
& edit .gaz 

Input 
System File 

Using a 
Gazetteer 

Input column 
parameters 

Input .gaz 
file

Output 
System File 
name/label

Run 
Task 

System File 
details

Save and edit 
.cmd file*
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Step 3 – Output from rezoned origin/destination file: 
 

 
 

 
 

 
 
 

 
* remember to check the ‘Apply to both axes’ tick box to save making origin/destination 
selections separately 
 

Output CSV 
file 

What sort of 
task is this? 

Input 
System File 

Select Areas* 
Output file 

name 
‘Go Mapping’ Run 

Task

Retrieve 
boundary file 

Search & 
select 

variables

Retrieve Desireline 
Area file 


